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13 marzo 2021 10251 Visualizzazioni Questa S Zone ti insegna diversi modi per ottenere aiuto con Paint in Windows 10. Scopri come eseguire diverse attivita in Paint e Paint 3D: gestisci la tela, disegna, cancella e fai altro. Dipingi 3D & una versione avanzata di Windows Paint. Come suggerisce il nome, a differenza di Paint, puoi disegnare forme 3D in
Paint 3D. Questa guida tratta gli argomenti della guida per entrambe le app. Questa guida di Windows 10 Paint and Paint 3D contiene una serie di argomenti. Per trovare l'argomento della guida di Paint che ti serve, espandi Sfoglia gli argomenti dei post di seguito, quindi fare clic sull'argomento. Tuttavia, se non conosci Paint o Paint 3D, puoi leggere
l'intera guida. Sarete contenti di averlo fatto! Il tempo di lettura stimato & di circa 47 minuti.Sfoglia gli argomenti dei post Aiuto con Paint in Windows 10: come aprire Paint e Paint 3D Se non conosci Paint o Paint 3D in Windows 10, avrai bisogno di aiuto per aprire le app. Questa sezione insegna vari modi per aprire Paint o Paint 3D in Windows 10.
Come aprire Paint o Paint 3D tramite la ricerca Tipo colore nella casella di ricerca di Windows 10: la casella di ricerca si trova nella parte inferiore sinistra della barra delle applicazioni. Quindi, dal risultato della ricerca, apri Colore o Pittura 3D . Clicca il Menu iniziale . Quindi, per aprire Colore , individuare ed espandere Accessori per finestre .
Infine, dal Accessori per finestre elenco, fare clic Colore . Aprire Dipingi 3D , dal menu Start, scorrere fino a P (Il menu Start & organizzato in ordine alfabetico). Quindi, fare clic Dipingi 3D . Hai ancora bisogno di aiuto con altri modi per aprire Paint in Windows 10? Ne abbiamo uno in piu per te. Se sei un tecnico, adorerai questo! Come aprire Paint
dal comando Esegui Puoi aprire Paint da Esegui. Per aprire il comando Paint from Run, segui i passaggi seguenti: Fare clic con il pulsante destro del menu Start, quindi fare clic su Correre . Infine, sul comando Esegui, digita mspaint e fare clic su OK. Aiuto con Paint in Windows 10: come ridimensionare e gestire la tela in Paint and Paint 3D Una volta
che hai dimestichezza con l'apertura di Paint o Paint 3D, il prossimo importante argomento della guida di Windows 10 Paint e la gestione di Paint Canvas. La tela € la parte di Windows 10 Paint o Paint 3D che contiene la tua immagine. Guarda la parte evidenziata degli screenshot di seguito. Il primo screenshot mostra la tela per Paint, il secondo
screenshot e per Paint 3D. Nelle seguenti sottosezioni imparerai come ridimensionare Windows 10 Paint e Paint 3D Canvas. Imparerai anche come aggiungere governanti, Linee della griglia , o Barra di stato in vernice. Come ridimensionare la tela in Microsoft Paint Ci sono piu posti per regolare e gestire le dimensioni di Canvas in Paint. Questa
sezione mette in evidenza queste opzioni. Regola la tela di pittura dalle proprieta della pittura In alto a sinistra di Paint, fai clic su File . Quindi, seleziona Proprieta . Quindi, all'apertura di Paint Properties, cambia la tela Larghezza e Altezza - e fare clic su OK. Per regolare la tela alla sua dimensione predefinita, usa il Predefinito pulsante. Regola
Dipingi tela dalla scheda Visualizza Puoi anche regolare la dimensione della tela di pittura da Visualizzazione scheda. Per iniziare, fai clic su Visualizzazione Tab. Quindi, nella scheda Visualizza, utilizzare la funzione Zoom su entrambi Ingrandire (aumentare la dimensione della tela) - o utilizzare Rimpicciolisci per ridurre le dimensioni della tela. Puoi
anche ridimensionare rapidamente la tela passando il mouse sulla parte inferiore destra della tela. Quando passi il mouse, il tuo mouse si trasformera in 2 frecce di puntamento. Quando il puntatore del mouse cambia, trascina verso il basso per aumentare le dimensioni della tela. In alternativa, per aumentare le dimensioni della tela, trascina verso
I'alto. Come ridimensionare la tela in Paint 3D La maggior parte degli utenti che non conoscono Windows 10 Paint 3D desiderano ricevere aiuto per imparare a ridimensionare la tela in questo strumento avanzato di Paint. Fortunatamente, e piu facile di quanto immagini! Per ridimensionare le dimensioni di Paint 3D Canvas, utilizzare il + e - segni sul
secondo menu. Per aumentare le dimensioni della tela, fare clic su + cartello. Tuttavia, se desideri ridurre le dimensioni della tela, fai clic su - cartello. C'e un altro argomento della guida di Windows 10 Paint in questa sezione. Nella prossima sottosezione imparerai come aggiungere governanti , Linee della griglia , o Barra di stato in vernice. Come
aggiungere righelli, linee della griglia o barra di stato in Microsoft Paint Se devi aggiungere righelli, griglie o rimuovere la barra di stato in Microsoft Paint, puoi accedere a queste funzionalita dal Visualizzazione scheda.I righelli e le linee della griglia sono disabilitati per impostazione predefinita mentre la barra di stato & abilitata per impostazione
predefinita. Come puoi vedere dallo screenshot qui sotto, puoi anche visualizzare 1'immagine a schermo intero tramite il Visualizzazione scheda. Aiuto con Paint in Windows 10: come disegnare e cancellare in Paint and Paint 3D Hai bisogno di aiuto per imparare a disegnare o cancellare in Windows 10 Paint o Paint 3D? Questa sezione tratta questi
argomenti. Come disegnare linee libere in Windows Paint Prima di iniziare a disegnare in Windows 10 Paint, potresti aver bisogno di aiuto per comprendere le funzionalita di disegno disponibili. Le funzionalita di cui hai bisogno sono evidenziate nello screenshot qui sotto. Prima di iniziare a disegnare, il tuo primo compito e modificare i colori di primo
piano e di sfondo. Il colore di primo piano e evidenziato nello screenshot qui sotto: rosso intenso. Questo ¢ il colore principale del tuo disegno. La seconda schermata qui sotto evidenzia il colore di sfondo: bianco. Per modificare uno di questi colori, fare clic su di esso. Quindi, dai colori visualizzati, seleziona il tuo colore preferito. Dopo aver selezionato
i colori preferiti, potresti voler cambiare il colore della tela. Per cambiare il colore della tua tela: Fare clic su Colore 1 o Colore 2 per selezionarlo. Poi, sul Utensili sezione, fare clic su Riempimento colore. Quindi, per riempire la tela con il colore di primo piano, fare clic con il pulsante sinistro del mouse la tela. In alternativa, se vuoi riempire la tela
con il colore di sfondo, fare clic con il pulsante destro del mouse sulla tela.Nella prima schermata qui sotto, facendo clic con il pulsante sinistro del mouse la tela 1'ha riempita con il mio colore di primo piano (rosso). Inoltre, il secondo screenshot mostra il mio colore di sfondo che riempie la tela, ottenuto da facendo clic con il pulsante destro del mouse
la tela. Ora, alla guida di Windows 10 Paint per questa sezione: imparare a disegnare! Per disegnare a mano libera, seleziona un colore di primo piano e fai clic sullo strumento matita. Quindi, disegna liberamente all'interno della tela. Per regolare la larghezza della linea, prima di iniziare a disegnare, fare clic su Misurare menu a discesa e selezionare
la larghezza della linea desiderata. Nello screenshot qui sotto, la linea bianca piu spessa viene disegnata con la dimensione piti ampia che ho selezionato. Infine, per espandere il tuo lavoro, fai clic sullo strumento lente di ingrandimento. Come disegnare forme in Windows Paint Un altro importante argomento della guida di Windows 10 e imparare a
disegnare forme con Microsoft Paint. Per disegnare forme, fai clic sulla forma che desideri disegnare. Quindi, trascina il mouse sulla parte della tela di cui vuoi disegnare la forma.Se la forma che vuoi disegnare non viene visualizzata, fai clic sull'icona di altre forme (la mia freccia punta su di essa nello screenshot qui sotto). Come disegnare linee
libere in Windows Paint 3D Aprire Dipingi 3D , quindi fare clic Nuovo - per aprire un nuovo documento. In alternativa, se disponi di un'immagine esistente, fai clic su Aprire invece. Quindi, nel menu in alto di Paint 3D, fai clic sull'icona 2D. Quando si fa clic sull'icona 2D, Linea e curve verra visualizzato nel riquadro di destra. Fare clic sulla forma della
linea che si desidera disegnare. Quindi, all'interno della tela, disegna liberamente. Una volta tracciata la linea, Paint 3D visualizzera ulteriori opzioni di personalizzazione nel riquadro di destra (evidenziato nello screenshot qui sotto).Con le opzioni della linea nel riquadro di destra, puoi modificare il colore e lo spessore della linea. Inoltre, puoi
modificare 1'opacita della linea o renderla una forma 3D. Infine, puoi ruotare o capovolgere la forma. Come disegnare forme 2D e 3D in Windows Paint 3D Questa sottosezione della guida in linea di Windows 10 Paint include i passaggi per creare forme in Paint 3D. Segui i passaggi seguenti per creare forme 2D o 3D: Nel menu in alto, fai clic sul tipo di
forma che desideri disegnare: 2D o 3D. Vedi la parte evidenziata dello screenshot qui sotto. Quando si fa clic sull'icona, nel riquadro destro di Paint 3D verranno visualizzate opzioni aggiuntive. Quindi, dalle opzioni visualizzate, fai clic sulla forma che desideri disegnare.Le forme 2D nel Dipingi 3D app sono simili alle forme nel normale Microsoft Paint.
Infine, per disegnare la forma 2D, fare clic con il mouse una volta nella posizione in cui desideri la forma nella tela.La forma verra visualizzata sulla tela. Verra inoltre evidenziato con linee tratteggiate attorno ad esso. Puoi espandere o ridurre le dimensioni della forma trascinando i piccoli quadrati attorno ai bordi. Inoltre, nel riquadro di destra
verranno visualizzate opzioni aggiuntive, per cambiare colore, spessore e altro. Inoltre, per disegnare forme 3D Dipingi 3D, nel menu in alto, fare clic sull'icona 3D. Quindi, nel riquadro di destra, fai clic sulla forma 3 che desideri disegnare. Infine, fai clic in un punto qualsiasi della tela per disegnare la forma. Quando si fa clic sull'icona 3D nel menu in
alto, una delle opzioni visualizzate nel riquadro di destra & Apri la libreria 3D . Fare clic qui per visualizzare piu forme 3D: vedere i 2 screenshot di seguito. Se hai bisogno di aiuto per disegnare linee e forme in Windows 10 Paint, potresti anche aver bisogno di aiuto per cancellare i disegni. Le 2 sottosezioni successive offrono una guida dettagliata per
cancellare il disegno da Microsoft Paint e Paint 3D. Come cancellare in Windows Microsoft Paint Per cancellare parti del tuo disegno in Paint, procedi nel seguente modo: Nella sezione Strumenti, fare clic su Gomma attrezzo. Quindi, fai scorrere il mouse sulla parte (s) del disegno che desideri cancellare.La facilita di Microsoft Paint funziona come
I'utilizzo della gomma che utilizziamo per cancellare i segni di matita sulla carta. Potrebbe essere necessario eseguire piu volte il mouse per ottenere una cancellazione chiara. Nello screenshot qui sotto, ho cancellato la parte sinistra della forma ovale. Nella seconda immagine qui sotto, ho sostituito la parte che avevo cancellato con una forma ovale
pil piccola, dandomi un bel design! Aiuto con Paint in Windows 10: come aggiungere testi in Paint e Paint 3D Hai cercato di capire come aggiungere testi in Paint? Alleggerisciti poiché questa parte della nostra guida della guida di Windows 10 Paint semplifica questo argomento. Questa sezione & divisa in 2 sottosezioni: la prima sottosezione copre i
passaggi per aggiungere testi in Microsoft Paint. Inoltre, la seconda sottosezione illustra i passaggi per aggiungere testi in Microsoft Dipingi 3D . Come aggiungere testi in Microsoft Paint Nella sezione Strumenti, fare clic su Testo attrezzo. Quindi, trascina il mouse sulla parte della tela in cui desideri aggiungere alcuni testi.Una volta attivato lo
strumento di testo, il menu Paint visualizzera gli strumenti di formattazione del testo standard. Avrai la possibilita di cambiare il carattere del testo, grassetto, corsivo o sottolineare il testo. Inoltre, il menu di testo offre la possibilita di aumentare la dimensione del carattere del testo e altro ancora. Per aggiungere un testo, all'interno dello strumento
testo nell'area di lavoro, digita normalmente. Inizialmente, la dimensione del carattere del testo potrebbe essere molto piccola. Per aumentare il carattere, evidenziare 1l'intero testo (fare clic e trascinare). Quindi, fai clic sul menu a discesa della dimensione del carattere (il mio mostra 11 nello screenshot qui sotto) e seleziona una dimensione del
carattere piu grande. Puoi anche cambiare il colore del testo: per fare cio, seleziona un colore diverso. Come puoi vedere nello screenshot qui sotto, la mia dimensione del testo & ora 20 mentre il colore & cambiato da bianco a giallo. Questo € il tuo corso accelerato di aiuto per il testo di Windows 10 Paint! Come aggiungere testi in Microsoft Paint 3D
Nel menu in alto di Paint 3D, fare clic su Testo icona. La parola Testo sotto la T potrebbe essere nascosta per te. Dopo aver fatto clic sull'icona Testo, trascina sulla parte della tela in cui desideri aggiungere un testo.Quando trascini all'interno della tela con lo strumento testo, verra creata ed evidenziata una casella di testo. Per aggiungere testo
nell'immagine, digita semplicemente. Se desideri aumentare le dimensioni della casella di testo, passa il mouse su una delle minuscole caselle quadrate bianche sul bordo e trascina. Dopo aver aggiunto i tuoi testi, puoi regolarne i caratteri con gli strumenti dei caratteri nel riquadro di destra. uno - viene utilizzato per modificare il nome del carattere
del testo Due - serve per regolare la dimensione del testo 3 - Usalo per regolare il colore 4 - Rendi il testo in grassetto, corsivo o sottolineato 5 - Allineare i testi a sinistra, al centro o a destra Aiuto con Paint in Windows 10: come copiare e incollare immagini in Paint e Paint 3D Questa sezione della nostra guida di Windows 10 Paint ti insegna diversi
modi per copiare, tagliare e incollare in Paint e Paint 3D. Come copiare e incollare in Microsoft Paint Esistono varie operazioni di copia e incolla che puoi eseguire in Microsoft Paint. Innanzitutto, puoi copiare una linea o una forma che hai disegnato in precedenza in Paint. Quindi, incollalo da qualche altra parte all'interno della tela. In questo
esempio, voglio copiare la mia forma ovale e incollarla in un'altra parte della tela. Per iniziare, fai clic su Selezionare menu a discesa degli strumenti. Quindi, dal menu a discesa Seleziona, fare clic su Selezione rettangolare attrezzo. Con lo strumento di selezione, trascina intorno all'oggetto (o parte di un oggetto) che desideri copiare: l'oggetto avra
ora delle linee rettangolari tratteggiate attorno ad esso. Infine, per copiare 1'oggetto evidenziato in Paint, fare clic con il pulsante destro del mouse e fare clic copia .Se desideri rimuovere 1'oggetto dalla sua posizione corrente e incollarlo da qualche altra parte nell'area di lavoro, fai clic su Taglio , invece di copia . Come puoi vedere dallo screenshot
qui sotto, il display del tasto destro offre alcune altre opzioni come Raccolto, Seleziona tutto , Eliminare, e altro ancora. Inoltre, con I'elemento copiato negli appunti, fai clic con il pulsante destro del mouse in un punto qualsiasi della tela in cui desideri incollare 1'elemento e seleziona Impasto . Quindi, trascina 1'elemento appena incollato nel punto in
cui lo desideri sulla tela. Puoi anche copiare un'immagine dall'esterno di Microsoft Paint e incollare 1'immagine in Paint. A tale scopo, in alto a sinistra di Microsoft Paint, fare clic su Impasto menu a discesa e selezionare Incolla da . Infine, sul Incolla da finestra di dialogo, apri la cartella con la foto o I'immagine che desideri incollare. Quindi, seleziona
l'immagine e fai clic su Apri. L'immagine verra incollata in Paint. Come copiare e incollare in Paint 3D Paint 3D offre opzioni di copia e incolla piu avanzate. Ad esempio, puoi fare clic con il pulsante destro del mouse su un'immagine al di fuori di Paint 3D e selezionarla copia . Quindi, apri Paint 3D, fai clic con il pulsante destro del mouse in un punto
qualsiasi della tela e seleziona Impasto . Aiuto con Paint in Windows 10: come aprire le immagini in Paint e Paint 3D Vuoi aprire un'immagine esistente in Paint o Paint 3D? Questa sezione della guida di Windows 10 Paint spiega come farlo. Per aprire un'immagine in Microsoft Paint, fare clic in alto a sinistra File . Quindi, dalle opzioni disponibili, fare
clic su Aprire . Infine, apri la cartella con 'immagine, seleziona 1'immagine e fai clic Aprire . Puoi anche aprire un'immagine in Paint 3D facendo clic sul Menu in alto a sinistra. Quindi, dalle opzioni visualizzate, Aprire & selezionato per impostazione predefinita. Nel riquadro dei dettagli, fare clic su Sfoglia i file . Infine, vai alla cartella con l'immagine
che desideri e aprila. Aiuto con Paint in Windows 10: come eliminare oggetti in Paint e Paint 3D Questa sezione della guida della guida di Windows 10 Paint ti insegna come eliminare le immagini in Paint e Paint 3D. Per eliminare un oggetto o una parte di un oggetto in Microsoft Paint, fare clic sul menu a discesa Seleziona strumento. Quindi, dalle
opzioni a discesa, fare clic su Selezione rettangolare . Con il Selezione rettangolare strumento, trascinare il mouse sull'oggetto (o parte dell'oggetto) che si desidera eliminare. La parte dell'immagine su cui hai trascinato lo strumento Selezione avra dei punti intorno. Per eliminare, & possibile premere il Eliminare tasto sulla tastiera. In alternativa, fare
clic con il pulsante destro del mouse sull'area e selezionare Eliminare . Quella parte dell'immagine verra eliminata: guarda il secondo screenshot qui sotto. Per eliminare in Paint 3D, fare clic su Testo icona nel menu in alto. Quindi, trascina il mouse sull'immagine o parte di essa. Infine, premere il Eliminare tasto sulla tastiera. In alternativa, fare clic
con il pulsante destro del mouse sull'area evidenziata e selezionare Eliminare . Aiuto con Paint in Windows 10: come unire le immagini in Microsoft Paint e Paint 3D Nella mia carriera di scrittore, di tanto in tanto, e sorta la necessita di unire due immagini in Microsoft Paint. Ogni volta che ne ho bisogno, uso Microsoft Paint per unire le foto. In questa
sezione della guida di Windows 10 Paint, ti mostrero come unire le foto con Microsoft Paint o Paint 3D. Come unire le immagini in Microsoft Paint Per importare la prima foto in Paint, fare clic su Impasto menu a discesa e selezionare Incolla da . Quindi, seleziona la foto e aprila. Per creare spazio per la seconda foto, trascina la prima foto a sinistra oa
destra, a seconda di dove vuoi che si trovi nella nuova foto unita. Ripetere i passaggi 1 e 2 per importare la seconda foto. Quindi, trascina la seconda foto nel punto desiderato nell'area di lavoro. Infine, puoi salvare le nuove foto unite (File -> Salva). In alternativa, usa CTRL+A per selezionare la foto e copiarla. Ecco la mia foto unita qui sotto: ho
semplicemente selezionato tutto, copiato e incollato qui! Come unire le immagini in Paint 3D Se invece preferisci lavorare con Paint 3D, ecco i passaggi per unire le foto in Paint 3D: In alto a sinistra di Paint 3D, fai clic su Menu. Quindi, dalle opzioni visualizzate, fai clic su Inserisci: individua la foto e inseriscila in Paint 3D. Dopo aver inserito la prima
foto, premere Ctrl e A tasti per selezionarlo. Quindi, trascinalo nella parte della tela che desideri nella foto unita. Ripetere i passaggi 1-3 per inserire la seconda foto. Quindi, trascinalo dove vuoi nella foto unita. Ecco la mia foto unita! Aiuto con Paint in Windows 10: come ritagliare, ruotare e ridimensionare le immagini in Paint e Paint 3D Siamo ora
nella nona sezione di questa guida completa di Windows 10 Paint. In questa sezione tratteremo il ritaglio, la rotazione e il ridimensionamento delle immagini in Paint e Paint 3D. Come ritagliare un'immagine in Microsoft Paint Per ritagliare un'immagine in Microsoft Paint, attenersi alla seguente procedura: Clicca il Selezionare cadere in picchiata.
Quindi, fai clic sul tuo strumento di selezione. In questo esempio usero il Selezione rettangolare attrezzo. Con lo strumento di selezione selezionato, fai clic sull'immagine che desideri conservare. In questo esempio, voglio mantenere 1'immagine a destra e rimuovere quella a sinistra. Trascinero il mouse intorno all'immagine a destra.Quindi, nella
sezione Immagine del menu Microsoft Paint, fare clic su Raccolto . La mia immagine & stata ritagliata e ora mostra solo la parte che voglio conservare. Come ruotare o capovolgere un'immagine in Microsoft Paint La rotazione di un'immagine e un'altra guida essenziale di Windows 10 Paint. Ecco i passaggi per ruotare un'immagine in Microsoft Paint:
Nella sezione Immagine del menu Pittura, fare clic su Ruotare cadere in picchiata. Quindi, seleziona i gradi di cui desideri ruotare l'immagine. Puoi anche capovolgere l'immagine in verticale o in orizzontale. Ecco l'immagine sopra capovolta in orizzontale, cambiando efficacemente la posizione delle 2 persone nell'immagine! Come ridimensionare
I'immagine in Microsoft Paint Per ridimensionare un'immagine in Microsoft Paint: Clic Ridimensiona nel Immagine sezione del menu Pittura. Microsoft Paint offre 2 opzioni di ridimensionamento. Puoi ridimensionare per percentuale (impostazione predefinita) o per pixel. Per regolare la dimensione dell'immagine utilizzando il Percentuale funzione,
cambiare il Orizzontale e Verticale % i valori. Il valore predefinito € 100. In questo esempio, voglio ridurre 'immagine al 50% della sua dimensione attuale. cambiero il Orizzontale % valori a 50. Perché la Casella di controllo Mantieni proporzioni e selezionato, quando inserisco 50 nel file Orizzontale campo, 50 verra visualizzato anche nel Verticale
campo. Infine, per salvare la nuova dimensione, fare clic su OKSi consiglia di lasciare il Casella di controllo Mantieni proporzioni controllato. In questo modo, la tua immagine manterra le sue dimensioni originali. Come si vede nello screenshot qui sotto, l'immagine si e ridotta del 50% su entrambi i lati. Puoi ridimensionare qualsiasi immagine di
qualsiasi valore %. Inoltre, puoi ridimensionare un'immagine utilizzando 1'opzione Pixel. Per fare cio, seleziona Pixel nella schermata delle opzioni di ridimensionamento. Quindi, inserisci i nuovi valori Pixel e fai clic su OK. Come ritagliare e ridimensionare le immagini in Paint 3D Rispetto a Microsoft Paint, lo strumento di ritaglio in Paint 3D e piu
avanzato. Ecco come utilizzare lo strumento di ritaglio in Paint 3D: Nel menu in alto di Paint 3D, fare clic su Ritaglia. L'immagine verra evidenziata e nel riquadro di destra verranno visualizzate ulteriori opzioni di ritaglio. Per un ritaglio rapido, seleziona una delle opzioni predefinite nella sezione Scegli l'inquadratura. Puoi anche fare clic su
Personalizzato per aggiungere una cornice personalizzata. Piu in basso in quel riquadro, puoi modificare la Larghezza e 1'Altezza del mago. C'é anche un'opzione per Blocca le proporzioni .Quando tu Blocca le proporzioni , la larghezza dell'immagine e 1'altezza si regoleranno proporzionalmente. Questa € una buona idea se si decide di regolare
manualmente 1'altezza e la larghezza dell'immagine. Per imparare la differenza tra ritaglio e ridimensionamento, leggi Qual e la differenza tra ritagliare e ridimensionare? Infine, quando hai finito di selezionare le opzioni di ritaglio, fai clic su nella parte inferiore del riquadro a destra Fatto . Come ruotare o capovolgere le immagini in Paint 3D Segui i
passaggi seguenti per ruotare o capovolgere un'immagine in Paint 3D Apri l'immagine che desideri ruotare o capovolgere in Paint 3D. Quindi, premere Ctrl e A tasti della tastiera per selezionare l'immagine. Una volta selezionata 1'immagine, nel riquadro destro di Paint 3D verranno visualizzate opzioni aggiuntive. Nella parte inferiore del riquadro a
destra, usa le prime 2 icone per ruotare l'immagine e le ultime 2 per capovolgere. Aiuto con Paint in Windows 10: come salvare in Paint e Paint 3D Dopo aver svolto tutto il duro lavoro in Windows 10 Paint o Paint 3D, avrai sicuramente bisogno di aiuto per salvarlo. Questa sezione mostra come salvare in Microsoft Pain and Paint 3D. Come salvare in
Microsoft Paint Esistono 2 metodi per salvare il tuo lavoro in Microsoft Paint. Puoi premere il Ctrl e S scorciatoia da tastiera o utilizzare il menu File. Quando premi Ctrl + S tasti, se si salva l'immagine per la prima volta, verra visualizzata la finestra di dialogo Salva con nome. Tuttavia, se in precedenza avevi salvato 1'immagine, quando premi Ctrl + S
chiavi, tutte le modifiche recenti verranno salvate. Per accedere all'opzione Salva o Salva con nome tramite il menu File, fare clic su File nel menu Microsoft Paint. Come salvare in Paint 3D Come in Microsoft Paint, premendo il tasto Ctrl e S tasti in Paint 3D apre la finestra di dialogo Salva con nome se stai salvando l'immagine per la prima volta.
Tuttavia, se l'immagine & stata precedentemente salvata, premendo Ctrl e S keys salva le modifiche recenti. Per accedere alle aperture Salva con nome e Salva senza la scorciatoia da tastiera, fare clic su Menu . Quindi, dalle opzioni visualizzate, seleziona Salva o Salva come . Se selezioni Salva Aiuto con Paint in Windows 10: come stampare in Paint e
Paint 3D Un certo numero di utenti di Windows 10 desidera anche ottenere assistenza con la stampa in Paint o Paint 3D. Questa sezione offre aiuto per questo argomento. Come stampare in Microsoft Paint Per stampare un'immagine in Microsoft Paint, puoi utilizzare il collegamento Stampa di Windows: Ctrl e P tasti, premuti contemporaneamente.
Tuttavia, puoi anche accedere all'opzione di stampa da File menu. Quando passi il mouse su Stampa (tramite il menu File), Microsoft Paint offre 3 opzioni: Stampa , Impostazione della pagina , e Anteprima di stampa . Per aprire la finestra di dialogo Stampa, fare clic su Stampa . Tuttavia, per regolare le impostazioni di stampa, Impostazione della
pagina . Entro Impostazione della pagina (vedi lo screenshot qui sotto), puoi regolare il formato della carta e cambiare 1'origine della carta della stampante. Inoltre, puoi selezionare se stampare l'immagine in Paesaggio (predefinito) o Ritratto . Infine, puoi modificare la stampa dell'immagine Centraggio e¢/o Ridimensionamento . Torna alle opzioni di
stampa, puoi anche selezionare Anteprima di stampa . Come stampare in Paint 3D Come in Microsoft Paint, puoi stampare in Paint 3D premendo Ctrl e P chiavi contemporaneamente. Questo apre la finestra di dialogo di stampa. La finestra di dialogo Paint Print ha tutte le opzioni di stampa standard. E possibile modificare 1'orientamento di stampa
dell'immagine e il formato carta.come presentare gli amici su facebook La finestra di dialogo Stampa offre anche altre opzioni Ridimensionamento, Allineamento e numero di copie. Quando sei pronto per stampare, fai clic su Stampa in basso a sinistra. Aiuto H2 con Paint in Windows 10: come inviare un'immagine tramite e-mail e come sfondo del
desktop in Paint Questo e un altro argomento della guida di Windows 10 Paint: invio di un'immagine tramite e-mail o impostazione e immagine come sfondo del desktop. Come impostare 1'immagine come sfondo del desktop in Microsoft Paint Per impostare un'immagine come sfondo del desktop da Microsoft Paint: Clic File e passa il mouse su Imposta
come sfondo del desktop. Quindi, seleziona un'opzione di sfondo. Come inviare un'immagine tramite e-mail in Microsoft Paint Per inviare un'immagine tramite e-mail da Microsoft Paint, fare clic su File. Quindi, seleziona Invia per e-mail . Paint aprira l'immagine nel tuo client di posta elettronica predefinito. Aiuto con Paint in Windows 10: scorciatoie
da tastiera di Windows Paint Stiamo arrivando alla fine della nostra guida della guida di Windows 10 Paint. Questa sezione & un elenco completo delle scorciatoie da tastiera di Paint e di cosa fanno. S/NTastiera Scorciatoia da tastieraCosa realizza la scorciatoiauno Ctrl e IN chiaviApre la schermata delle impostazioni Ridimensiona e inclinaDue Ctrl e n
chiaviChiude l'immagine corrente e apre una nuova tela vuota3 Qualunque cosa e v chiaviPassa a Pittura Visualizzazione scheda4 Qualunque cosa e h chiaviPassa a Pittura Casa scheda5 Ctrl e O chiaviApre la finestra di dialogo Paint Open, in modo da poter aprire un'immagine esistente in Paint.6 Ctrl e S chiaviSalva le modifiche apportate in
Microsoft Paint. F12 chiaveApre il Salva come dialogo7 Ctrl e R chiaviMostra o nasconde il righello - accessibile anche tramite il Visualizzazione menu.8 Ctrl e P chiaviApre la finestra di dialogo Stampa per stampare l'immagine in Paint9 Ctrl e G chiaviAggiunge o rimuove le linee della griglial0 Qualunque cosa e F4 chiaviChiudi Microsoft Paintundici
Ctrl e E chiaviVisualizza le proprieta dell'immagine9 Ctrl e CON chiaviAnnulla l'ultima azionel0 Ctrl e A chiaviSeleziona l'intera tela in Microsoft Paintundici Ctrl e C chiaviCopia un'area selezionatal2 Ctrl e v chiavilncolla I'elemento negli appunti - Ctrl + v incolla un elemento indipendentemente dal fatto che sia stato copiato da Paint o da un'altra
app Qualunque cosa e F chiaviApre il menu File di pittural3 Ctrl e Pagina su chiavilngrandire. Simile a Ctrl e Scorri il mouse verso 1'alto 14 Ctrl e Pagina giu chiaviRimpicciolisci. Simile a Ctrl e Scorrimento del mouse Giu quindici Ctrl e u chiaviSottolinea il testo selezionato16 Ctrl e B. chiaviTesto selezionato in grassetto17 Ctrl e io chiaviMetti in
corsivo il testo selezionato18 F1 chiaveApre i risultati della ricerca per assistenza con Paint in Windows 10 in Bing.com19 F11 chiaveVisualizza I'immagine in modalita Schermo interoventi Esc chiaveAnnulla la selezione esistenteventuno Eliminare chiaveElimina una selezione Aiuto con Paint in Windows 10: domande frequenti In questa sezione finale,
rispondero alle domande piu frequenti della guida di Windows 10 Paint. 1. Come posso ripristinare la vernice su Windows 10? Microsoft Paint & installato in Windows 10 per impostazione predefinita. Tuttavia, se cerchi Colore e non riesci a trovarlo, segui i passaggi seguenti per ripristinare la vernice su Windows 10: 1 - Entra gestire le funzionalita
opzionali nella ricerca di Windows 10, quindi, aprilo dal risultato della ricerca 2 - Quando il Gestisci funzionalita opzionali si apre la schermata, fare clic aggiungi una caratteristica , Cercare Microsoft Paint e installalo. 2. Qual & il tasto di scelta rapida per aprire Paint? Microsoft Paint non dispone di una chiave breve per aprirlo direttamente. Tuttavia,
puoi aprirlo tramite il comando Esegui. Ecco i passaggi: 1 - Fare clic con il tasto destro del mouse sul menu della torta e fare clic Correre . 2 - Quando si apre Esegui, entrare MSPaint e fare clic su OK. Guarda gli screenshot qui sotto: 3. Cosa ha sostituito Paint in Windows 10? Windows Paint non viene sostituito in Windows 10. Windows 10 ha ancora
Microsoft Paint installato per impostazione predefinita. Tuttavia, Windows 10 ha un'app Paint avanzata chiamata Dipingi 3D . E possibile utilizzare Microsoft Paint o Paint 3D in Windows 10. Se per qualsiasi motivo Microsoft Paint non & disponibile nella copia di Windows 10, installarlo tramite Gestisci funzionalita opzionali . 4. Quali sono i passaggi
per avviare MS Paint? Segui i passaggi seguenti per avviare MS Paint in Windows 10: 1 - Premere il Logo di Windows e il tasto R contemporaneamente per aprire Esegui. 2 - Quando si apre Paint, digitare MSPaint e fare clic su OK. 5. Come possiamo aprire un disegno salvato in Paint? Per aprire un disegno salvato in Microsoft Paint, fare clic su in
alto a sinistra di Paint File . Quindi, dalle opzioni visualizzate, fare clic su Aprire . Infine, vai alla cartella in cui hai salvato il disegno, selezionala e fai clic su OK. Il disegno si aprira in Paint. Spero che tu abbia trovato utile questa guida di Windows 10 Paint? Se I'hai trovato utile, vota gentilmente si alla Domanda utile di questo post di seguito.Tuttavia,
se c'é un aiuto per Paint di cui hai bisogno ma non ¢ incluso in questa guida, fai clic su No alla Domanda utile di questo post di seguito. Quindi, fornisci gentilmente i dettagli dell'aiuto di Windows Paint che volevi che non ¢ incluso in questa guida. Esaminiamo il feedback dei nostri lettori e aggiorniamo le nostre guide per soddisfare costantemente le
tue esigenze.Inoltre, dedica un minuto a dirci cosa ne pensi di questa guida: utilizza il modulo Lascia un commento che si trova alla fine di questa pagina. Infine, per ulteriori Windows 10 S Zones, visita la nostra pagina How-To di Windows 10.Potresti anche trovare molto utile la nostra guida completa a Esplora file - Ottieni aiuto con Esplora file in
Windows 10: The Ultimate Guide . Hai necessita di apportare delle modifiche alle foto, come ad esempio dei ritagli o delle rotazioni dell’immagine. Conosci I’esistenza di software professionali che potrebbero fare al caso tuo, ma non hai interesse nel loro utilizzo perché a pagamento oppure troppo complessi. Sei alla ricerca, dunque, di strumenti per
eseguire modifiche rapide e basilari e sei curioso di sapere se Paint, strumento predefinito di Windows, possa soddisfare le tue esigenze. Come dici? Le cose stanno proprio in questo modo? Allora non devi preoccuparti in alcun modo, perché ci sono qui io a darti una risposta a questo quesito.Nella guida di oggi, ti illustrero come usare Paint per
svolgere delle operazioni semplici di modifica delle immagini, da eseguire in modo rapido su tutti i principali formati di file grafici. Inoltre, qualora ne avessi bisogno, ti parlero di Paint.NET, un software con molte funzionalita avanzate che potrebbero aiutarti in quelle modifiche non eseguibili su Paint.Allora: sei impaziente di leggere i consigli che ho
scritto per te in questa mia guida? Bene, a questo punto direi di iniziare immediatamente. Siediti bello comodo, presta attenzione ai consigli che ho preparato per te nelle prossime righe e prova a metterli in pratica. A me non resta altro da fare, se non augurarti una buona lettura e, soprattutto, un buon divertimento!IndicePaint € uno storico
programma disponibile su Windows, in modo completamente gratuito. Dato che non richiede alcuna installazione, in quanto gia preinstallato nel sistema operativo di Microsoft, per usarlo ti basta semplicemente avviarlo, ricercandolo nel menu dei programmi.Per fare cio, clicca sul pulsante Start (I'icona della bandierina collocata in basso sullo
schermo) oppure premi il tasto Win della tastiera. Fatto cio, puoi scrivere Paint nella barra di ricerca Cerca app, impostazioni e documenti e cliccare sul risultato. In alternativa, fai clic su Tutte le app e le vedrai in ordine alfabetico, dunque scorri 1’elenco e clicca su Paint appena la individui.Dopo averlo avviato, troverai una schermata bianca che
rappresenta l’area sulla quale poter disegnare oppure scrivere. In realta, pero, Paint puo essere utilizzato anche per modificare delle immagini preesistenti.L’utilizzo del programma e molto semplice: nella barra in alto trovi le schede seguite da tutti gli strumenti di Paint, mentre al centro trovi I’area di disegno per creare o modificare un’immagine.La
prima scheda & denominata File e permette di creare una nuova area di disegno (Nuovo), di aprire un’immagine archiviata sul computer (Apri), di salvare il progetto (Salva) o di crearne una copia in un formato differente (Salva con nome). Inoltre, puoi eseguire la stampa del progetto tramite la stampante o su un file PDF (Stampa) o acquisire una foto
dallo scanner o da una fotocamera, se connessi al PC (Da scanner o fotocamera). Puoi anche decidere di inviare il progetto di lavoro via email (Invia) oppure guardare le sue caratteristiche (Proprieta), per leggerne i dpi o modificare I’area di disegno, giusto per fare qualche esempio.Nella scheda Visualizza, puoi trovare alcune funzionalita come quelle
per modificare il livello di ingrandimento dell’area di lavoro oppure quelle per abilitare la griglia e il righello. Accanto c’e il pulsante per salvare il progetto (floppy disk) e le frecce per annullare una modifica o ripristinarla.Sotto le schede appena menzionate, invece, ci sono tutti i pulsanti da utilizzare per lavorare con Paint. Nella sezione Appunti trovi
i pulsanti Incolla, Importa, Copia e Ritaglia. In Immagine invece ci sono i vari pulsanti per apportare modifiche come Seleziona, Ruota, Ridimensiona, Capovolgi. Gli Strumenti invece sono la Matita, la Gomma, il pulsante Riempi per colorare una selezione del foglio, poi troverai il pulsante Seleziona colore, quello dello Zoom e anche il pulsante per
inserire Testo.Molto utili e sfiziosi sono i Pennelli: premendo sulla freccia in git compariranno tutte le punte tra cui puoi scegliere, come per esempio il Pennino, il Pennello a olio, il Pennarello, il Pastello, I’Aerografo e molti altri. Dovrai solo testarli tutti per scegliere il tuo preferito. Seleziona un Pennello e inizia a disegnare delle Forme, che puoi
scegliere cliccando direttamente su quella che piu ti piace. Accanto a questa scheda ci sono altri due pulsanti molto interessanti: quello per scegliere il Contorno (rettangolo con una matita) e quello per scegliere il Riempimento (rettangolo con secchiello di vernice).Infine puoi gestire le Dimensioni della punta del pennello (1px, 3px, 5px, 8px) come
anche i Colori: dovrai solo fare clic sulle voci e sui colori che ti piacciono per impostare il tuo pennello e iniziare a disegnare.Utilizzando la combinazione di questi strumenti che ti ho indicato nelle righe precedenti, puoi eseguire delle modifiche basilari all'immagine oppure creare semplici progetti di disegno. Se vuoi approfondire 1'uso di Paint, ti
consiglio di leggere alcune mie guide che ho realizzato, come ad esempio come ritagliare foto con Paint oppure come ridimensionare una foto con Paint.Come usare Paint per modificare immaginiVuoi sapere come usare Paint per modificare delle immagini? Il primo passo da compiere & importare I'immagine in questione sulla tela di Paint. Usa il menu
File > Apri collocato in alto a sinistra e cerca 'immagine in questione, selezionala e premi su Apri. In alternativa, raggiungi la cartella dove risiede I'immagine, fai clic destro su di essa e, nel menu contestuale che ti viene mostrato, seleziona la voce Modifica oppure le voci Apri con > Paint.Una volta importata I'immagine sulla tua tela, comincia a
modificarla aggiungendo Forme oppure disegnando a mano libera scegliendo il Pennello e il Colore che piu ti aggrada. Puoi anche aggiungere testo se lo desideri oppure sovrapporre due immagini.In caso desiderassi apportare ulteriori modifiche come per esempio ritocchi al viso oppure modificare luminosita, contrasto e quant’altro, allora ti consiglio
di usare dei programmi di fotografia piu avanzati, come per esempio Photoshop o altri programmi per modificare foto gratis.Se vuoi limitarti a usare Paint, allora scopri come modificare le foto leggendo la mia guida.Come usare Paint per scrivereUsare Paint per scrivere e davvero molto semplice. Scegli innanzitutto se farlo su tela bianca, o comunque
uniforme, oppure su delle immagini che avrai precedentemente importato, come abbiamo visto.Adesso fai clic sul pulsante Testo, € quello con la A nella scheda Strumenti. Comparira la barra degli strumenti del testo per scegliere il font, la dimensione del carattere, se impostarlo in grassetto, corsivo oppure sottolineato e sbarrato. Ci sono anche i tre
pulsanti per I’allineamento del testo. Mettendo la spunta alla voce Riempimento sfondo renderai bianco il campo di scrittura, dunque piu visibile nel caso scrivessi sopra a un’immagine. Naturalmente puoi servirti dei Colori per scegliere quello piti adatto al testo che vuoi scrivere.Una volta impostato il tutto, posiziona il cursore dove desideri scrivere e
inizia a digitare il testo. Procedi in maniera accurata al posizionamento del cursore perché non sara possibile spostare il testo in un secondo momento. Quando hai terminato di scrivere, fai clic in un altro punto qualsiasi del foglio e il gioco e fatto. Premendo Invio da tastiera, invece, Paint ti fa andare a capo per aggiungere altro testo.Come usare Paint
per disegnareDopo aver visto come scrivere, vediamo come disegnare con Paint. In realta & davvero molto semplice e intuitivo, I'unica cosa che dovrai avere per ottenere dei disegni perfetti & la manualita con il mouse. Tutto quello che devi fare & avviare un nuovo progetto per avere il tuo foglio bianco su cui disegnare.Adesso scegli da quale parte del
disegno cominciare e il pennello adatto per realizzare il primo oggetto. Puoi scegliere la Matita cosi come uno dei Pennelli, imposta il Colore e inizia a disegnare sul foglio: devi tenere premuto il tasto sinistro del mouse sulla tela per disegnare. Potresti anche usare le Forme per dare vita al tuo progetto e ricorda di usare lo strumento Riempi per
colorare le varie parti del disegno.Per esempio, scegli la forma del cuore e il colore rosso, quindi con il mouse disegnalo sulla tela facendo un clic e rilasciandolo quando la forma del cuore ti soddisfa. Adesso premi sul secchiello per riempire il disegno del cuore e fai clic all’interno del cuore: otterrai cosi un bel cuore rosso sulla tua tela. Per ottenere
una casa, invece, realizza prima un rettangolo o un quadrato servendoti delle Forme, poi scegli il triangolo e disegnalo sopra al quadrato: otterrai la facciata di una casa e il disegno risultera piu preciso usando le Forme.Casomai dovessi commettere degli errori puoi servirti della Gomma per cancellare oppure della freccia indietro per annullare
I'ultima modifica.Nel mio approfondimento su come fare disegni al PC troverai preziosi consigli per fare delle vere opere d’arte.Come usare Paint per sovrapporre due immaginiHai in mente un bel collage da realizzare per una sorpresa a cui stai pensando da tempo, cosi ti stai chiedendo come usare Paint per sovrapporre due immagini. Sarai felice di
sapere che e possibile ottenere questo risultato senza servirti di complicati programmi di fotografia.Infatti, a partire da fine 2023 su Paint sono state introdotte delle funzionalita che potresti trovare particolarmente utili per questo scopo. Mi riferisco alla gestione di trasparenza e livelli, cosa che chiaramente ti consente di sovrapporre immagini molto
meglio rispetto a quanto avveniva in precedenza.Se disponi dunque di una versione aggiornata di Paint, magari relativa a Windows 11, ti basta semplicemente aprire I'immagine di tuo interesse all’interno del programma, andando poi a premere sull’icona dell’omino con sfondo trasversale presente in alto a sinistra. Cosi facendo, infatti, riuscirai a
rendere lo sfondo trasparente, cosi da poter posizionare un’immagine “sotto” al soggetto principale.Ecco allora che potrebbe interessarti fare clic sulla voce Livelli, presente in alto a destra, cosi da far comparire un’apposita barra sulla destra. Premendo dunque sul tasto +, aggiungerai un layer, che fara da sfondo alla tua immagine. Potresti dunque
voler utilizzare 1'icona del secchio semplicemente per riempire con un colore lo sfondo, ma piu che altro potrebbe interessarti effettuare un copia e incolla dell’immagine di sfondo che vuoi utilizzare (puoi anche usare un’altra sessione di Paint per effettuare la selezione), cosi da averla a disposizione nel nuovo layer. Chiaramente, potresti voler fare
attenzione alle dimensioni, cercando di “ricalcare” quelle dell’'immagine del soggetto.Per il resto, potrebbe interessarti utilizzare il pannello di destra per spostare in alto il layer del soggetto, cosi da metterlo in primo piano rispetto allo sfondo. Perfetto, ora hai correttamente imparato a gestire la sovrapposizione delle immagini con trasparenza su
Paint. Chiaramente, in alternativa, potresti anche pensare di utilizzare il metodo classico, in cui i bordi delle immagini sono ben visibili, semplicemente trascinando un’immagine sopra ’altra, ma come puoi ben vedere col passare degli anni il programma ha effettuato passi in avanti non di poco conto. Tra ’altro, potrebbe magari interessarti dare
un’occhiata anche alla mia guida su come sovrapporre due immagini con Paint, in modo da fugare ogni dubbio.Al netto di questo, sempre mediante il gia citato aggiornamento di fine 2023, e arrivata una funzione di intelligenza artificiale chiamata Cocreator. In parole povere, mediante la pressione dell’apposito pulsante presente in alto a destra
nell’interfaccia del programma, risulta possibile generare immagini IA a partire da un semplice input testuale (che al momento in cui scrivo puo essere solo in inglese). Per maggiori dettagli su questa possibilita, potenzialmente sfruttabile anche per gli sfondi, potresti essere interessato a consultare le linee guida ufficiali di Microsoft (in quanto di
mezzo c’e anche un sistema di crediti).Come usare Paint 3DPaint 3D e un’applicazione per Windows 10 e 11 (non piu disponibile, dismessa da Microsoft a novembre 2024). Quest’app e simile a Paint ma porta con sé altre funzionalita, soprattutto nell’ambito della progettazione 3D, ed & studiata per essere utilizzata agevolmente sui dispositivi dotati di
touch-screen, come ad esempio i Microsoft Surface.Dopo aver avviato Paint 3D, nella finestra che ti viene mostrata, scegli se vuoi creare un nuovo progetto (Nuovo), aprirne uno gia creato o importare un’immagine salvata sul computer (Apri) oppure se incollare un elemento presente negli appunti (Incolla).Nella schermata principale, puoi trovare al
centro ’area di disegno, mentre sulla destra sono presenti gli strumenti con cui interagire sull’immagine. Nell’area superiore, invece, sono raccolti gli strumenti per categoria.Nella sezione Pennelli, trovi le diverse tipologie di tratti, che puoi utilizzare per il disegno a mano libera, la gomma da cancellare e il secchiello per il riempimento automatico di
un’area con un colore. Sono poi presenti le sezioni Forme 2D e Forme 3D, per aggiungere modelli predefiniti di forme oppure oggetti da inserire nel proprio progetto. Nella scheda Adesivi, invece, puoi trovare gli strumenti per aggiungere adesivi predefiniti o personalizzati da applicare all’'immagine oppure su una facciata di una specifica forma
geometrica.Nella sezione Testo, puoi creare delle caselle di testo per aggiungere delle didascalie all'immagine. La sezione Effetti permette di cambiare I’angolo di proiezione della luce e il colore della stessa. Se vuoi modificare 1’angolo di rotazione dell'immagine oppure la sua risoluzione, invece, puoi interagire con gli strumenti presenti nella sezione
Area di disegno. Inoltre, in Paint 3D puoi importare dei modelli 3D presenti nel database, utilizzando il pulsante in alto Libreria 3D. Puoi accedere a tanti modelli divisi per categoria da importare nel tuo progetto.Uno strumento interessante, che non & presente in Paint ma che trovi in Paint 3D, e la Selezione magica, la quale permette di ritagliare
I’elemento di un’immagine per estrarlo dallo sfondo, un po’ come la bacchetta magica di Photoshop.Dopo aver completato il progetto che intendi realizzare, premi sul pulsante in alto a sinistra Menu e scegli il pulsante Salva oppure Salva con nome, per cambiare il formato o la destinazione. Puoi anche decidere di stampare il progetto (Stampa) o di
condividerlo sui social network o via e-mail (Condividi). Se hai intenzione di aggiungere nuovi elementi al progetto, puoi utilizzare la funzione messa a disposizione tramite il pulsante Inserisci.Per maggiore supporto consulta il mio tutorial su come usare Paint 3D.Come usare Paint su MacSei passato da poco a un Mac ma eri troppo abituato a
utilizzare Paint con il tuo PC Windows. Per questo motivo adesso vorresti capire come usare Paint su Mac, ma questo € un programma Windows e non & possibile utilizzarlo sul tuo Mac.Ci sono delle validissime alternative, pero. Per esempio su App Store puoi trovare Paint S, con tanti strumenti per disegnare e un editor per immagini intuitivo e
semplice da usare.Permettimi di suggerirti anche dei programmi per disegnare su Mac da usare in alternativa a Paint.Come usare Paint su WordDopo aver realizzato un’immagine con Paint puoi importarla su Word. Quindi se stai lavorando a un progetto su Word e necessiti di un disegno, puoi realizzarlo comodamente su Paint e inserirlo in un
secondo momento.Quindi apri Paint, lavora al tuo disegno e quando hai terminato fai clic sul pulsante Selezione, & il rettangolo tratteggiato. Ora seleziona tutto il foglio o almeno il disegno da te realizzato e fai Copia, anche con la tastiera (Ctrl+C su Windows).Ora spostati sul foglio Word dove desideri inserire I'immagine in questione e posizionati con
il cursore nel punto in cui incollarla, quindi procedi su Home > Incolla oppure usa la tastiera (Ctrl+V). Hai ottenuto il tuo disegno di Paint su Word, ora puoi adattare I'immagine al foglio Word oppure spostarla. Valuta anche l'ipotesi di aggiungere una didascalia.Come usare Paint. NETPaint.NET e un software molto famoso per la modifica delle
immagini. E distribuito gratuitamente tramite il sito Web ufficiale, ma & possibile scaricarlo dal Microsoft Store al costo di 9,99 euro per supportare il team di sviluppo (non ci sono funzioni extra rispetto alla versione free). E un software abbastanza professionale che permette di svolgere funzioni avanzate che non possono essere eseguite tramite
Paint o Paint 3D; ad esempio, supporta gli strumenti avanzati come i livelli o gli effetti.Se sei interessato a questo software, raggiungi il link al sito Web ufficiale che ti ho precedentemente fornito. Nella home page, individua la dicitura Download che trovi nella barra dei menu in alto. Nella nuova sezione, fai clic su Download now, in corrispondenza
della dicitura Free, premi quindi sulla voce paint.net x.x.x che trovi in alto a destra per prelevare il file .zip che contiene il software.Dopo aver scaricato il file, fai doppio clic su di esso per aprire la cartella di Paint.NET e fai un altro doppio clic sul file .exe per avviare l'installazione del programma. A questo punto, premi sul pulsante Si nella finestra di
controllo dell’account utente di Windows e, nella schermata che si apre, seleziona la voce Rapida, per poi pigiare su Avanti. Adesso, scegli Accetto e premi nuovamente sul pulsante Avanti per far partire l'installazione di Paint.NET. Al termine della stessa, chiudi la schermata tramite il pulsante Fine.Dopo aver avviato il programma, premi sul pulsante
File, nella barra dei menu in alto, e scegli la voce Nuovo, per creare un nuovo progetto, oppure clicca sul pulsante Apri, per aprire un’immagine presente sul computer. A questo punto, utilizza la barra degli Strumenti a sinistra per aggiungere nuovi elementi all’immagine o per modificare quelli gia presenti.Ad esempio, puoi utilizzare la bacchetta
magica per scontornare un oggetto dallo sfondo oppure utilizzare il secchiello, la matita o la gomma per modificarlo. E anche presente il timbro clone per riprodurre una porzione dell'immagine da un punto ancorato. In basso a sinistra, invece, & presente una tavolozza per la selezione dei colori.Nella sezione di destra, poi, &€ presente un riquadro
relativo alla cronologia delle azioni eseguite sull'immagine, per poter tornare indietro a un punto precedente del lavoro, nel caso in cui si sia commesso qualche errore, e quello relativo ai livelli dell'immagine.Tramite la barra dei menu in alto, puoi accedere ad alcuni strumenti di modifica: la scheda Effetti, che permette di aggiungere degli effetti e
degli stili, come ad esempio la sfocatura o la pixelatura; la scheda Regolazioni, che permette la variazione di alcuni parametri, come la luminosita o la saturazione, e la scheda Immagini, che permette di applicare un ridimensionamento all’immagine, di effettuarne il capovolgimento o la rotazione.Dopo aver completato il progetto, ti basta fare clic sulle
voci File > Salva o File > Salva con nome nel menu in alto a sinistra per salvare le modifiche apportate. Puoi anche utilizzare la funzione Stampa per stampare il progetto tramite la stampante o in un file PDF, oppure puoi acquisire un’immagine dai dispositivi connessi, come lo scanner o la fotocamera, tramite la funzione Acquisisci. Semplice, vero?
Salvatore Aranzulla & il blogger e divulgatore informatico pitl letto in Italia. Noto per aver scoperto delle vulnerabilita nei siti di Google e Microsoft. Collabora con riviste di informatica e cura la rubrica tecnologica del quotidiano Il Messaggero. E il fondatore di Aranzulla.it, uno dei trenta siti piui visitati d'Italia, nel quale risponde con semplicita a
migliaia di dubbi di tipo informatico. Ha pubblicato per Mondadori e Mondadori Informatica. 1 Avvia Paint.[1] Puoi farlo come faresti nel caso di qualunque altro programma. Tuttavia la procedura da seguire puo variare leggermente in base alla versione di Windows in uso. Windows 10: accedi al menu "Start", clicca l'icona a forma di lente di
ingrandimento, digita la parola chiave paint, quindi seleziona l'icona "Paint" dall'elenco dei risultati della ricerca; Windows 8: posiziona il cursore del mouse nell'angolo superiore o inferiore destro, quindi scegli 'opzione "Cerca" dal menu laterale apparso (se hai un dispositivo touchscreen, scorri il dito sullo schermo da destra verso sinistra). Digita la
parola chiave paint, quindi seleziona l'icona "Paint" dall'elenco dei risultati della ricerca; Windows Vista e Windows 7: accedi al menu "Start", seleziona la voce "Tutti i programmi”, scegli 'opzione "Accessori" e infine seleziona 1'icona "Paint". 2 Apri un'immagine. Paint & in grado di gestire molti dei formati di file relativi alle immagini: BMP, GIF, JPG,
JPEG, TIF, TIFF, ICO e PNG. Per aprire un'immagine con Paint, accedi al menu "File" e scegli 1'opzione "Apri". A questo punto seleziona la cartella in cui & memorizzato il file che desideri caricare, selezionalo e premi il pulsante "Apri". 3 Comprendi come funziona la "tela" di Paint. Quando apri il programma la prima cosa che vedi & un'area totalmente
bianca all'interno della finestra; immagina che sia la tela di un pittore o un foglio bianco su cui poter disegnare o scrivere liberamente. E possibile ridimensionare la dimensione dell'area di lavoro di Paint prima di iniziare a creare il proprio capolavoro. Windows 7 e versioni successive: accedi alla scheda "Home", quindi scegli I'opzione "Ridimensiona".
Verra visualizzata una piccola finestra di dialogo con cui e possibile ridimensionare 1'area di lavoro. Scegli la voce "Pixel", quindi usa i campi "Orizzontalmente" e "Verticalmente" per inserire la dimensione desiderata in pixel. In alternativa puoi effettuare il ridimensionamento utilizzando una percentuale della dimensione attuale scegliendo il
radiopulsante "Percentuale" e inserendo la percentuale con cui desideri aumentare o diminuire la superficie attuale dell'area di lavoro. Per esempio se hai la necessita di dimezzare la dimensione attuale dell'immagine, dovrai inserire il valore 50 in ognuno dei due campi; al contrario, se desideri raddoppiarla, digita il valore 200. Windows Vista: accedi
al menu "Immagine", quindi scegli l'opzione "Attributi". Inserisci le dimensioni desiderate per l'area di lavoro (in pixel) utilizzando i campi di testo "Larghezza" e "Altezza". 4 Ritaglia una porzione di un'immagine.[2] Apri un'immagine esistente utilizzando Paint, quindi clicca l'icona dello strumento "Seleziona" posta nella parte superiore della finestra.
Adesso clicca 1'angolo superiore sinistro dell'area dell'immagine che desideri conservare, quindi trascina il mouse verso 1'angolo inferiore destro senza rilasciare il tasto sinistro, finché tutta la sezione interessata non € completamente inclusa nella selezione. A questo punto rilascia il tasto sinistro del mouse e clicca la voce "Ritaglia". 5 Ridimensiona
un'immagine. Accedi al menu "Immagine"”, quindi scegli I'opzione "Allunga/Inclina" (se stai utilizzando Windows 7 o0 una versione successiva, seleziona semplicemente l'icona "Ridimensiona" situata sulla barra degli strumenti). In alternativa, puoi utilizzare la combinazione di tasti di scelta rapida Ctrl+W per aprire direttamente la finestra di dialogo
"Ridimensiona e inclina". Digita il valore desiderato (in pixel o in percentuale, esattamente come hai fatto per ridimensionare l'area di lavoro di Paint) per incrementare o diminuire 1'attuale dimensione dell'immagine. 6 Ruota un'immagine. Per capovolgere verticalmente una foto (o ruotarla in altre direzioni), occorre utilizzare lo strumento
"Capovolgi/Ruota". Windows 7 e versioni successive: seleziona l'opzione "Ruota" posta sulla barra degli strumenti di Paint, quindi scegli una delle opzioni presenti nel menu a discesa apparso. Windows Vista: accedi al menu "Immagine", scegli l'opzione "Capovolgi/Ruota", quindi scegli in che direzione ruotare l'immagine. In alternativa, puoi usare la
combinazione di tasti di scelta rapida Ctrl+R per avere accesso diretto alla finestra di dialogo "Capovolgi e inclina". 7 Usa le funzionalita "Zoom avanti" e "Zoom indietro". Per abilitare 1'uso dello strumento "Zoom", clicca l'icona a forma di lente di ingrandimento. Per usare la funzione "Zoom avanti", clicca l'area di tuo interesse con il tasto sinistro del
mouse, mentre per sfruttare la funzione "Zoom indietro", usa il tasto destro del mouse. In alternativa, puoi utilizzare la combinazione di tasti di scelta rapida Ctrl+Pag Su per zoomare avanti e Ctrl+Pag Giu per zoomare indietro. 8 Impara come eliminare gli errori utilizzando la funzione "Annulla". Se hai commesso un errore utilizzando uno qualunque
degli strumenti di Paint, puoi sfruttare la funzionalita "Annulla" per cancellare 1'ultima azione eseguita premendo la combinazione di tasti Ctrl+Z. 9 Salva il lavoro fatto.[3] Accedi al menu o alla scheda "File", quindi seleziona la voce "Salva con nome" per scegliere dove salvare il file e con che nome. Avrai anche la possibilita di scegliere il formato di
file da utilizzare per il salvataggio. Questa scelta e basata sull'utilizzo successivo che dovrai fare dell'immagine. Il formato JPG € un'ottima scelta nel caso di immagini con molti colori o di fotografie. Se hai utilizzato pochi colori e l'immagine non e molto dettagliata, puoi usare il formato GIF, che € molto versatile e produce file dalle dimensioni
contenute. Se pensi di utilizzare il file solo con Paint, puoi scegliere il formato Bitmap (BMP), che & quello predefinito del programma. In ogni caso hai sempre la possibilita di convertire un'immagine in un altro formato di file. Consulta questo articolo per scoprire come convertire un'immagine JPEG in un altro formato. Pubblicita Come usare Paint Con
consigli dettagliati per sfruttare al meglio gli strumenti disponibili. Vengono anche presentate le versioni piu’ avanzate, come Paint 3D e Paint.NET. Come usare Paint Pennello, Seleziona, Gomma cancellino, Riempimento colore e Testo. Paint €’ uno dei programmi piu’ facili da utilizzare grazie alla sua interfaccia intuitiva. Dopo aver avviato il software
puoi cominciare subito a lavorarci sopra selezionando “File” dal menu principale e scegliendo “Nuovo”. Si aprira’ cosi una nuova finestra vuota su cui potrai disegnare o inserire la tua immagine preferita tramite la funzione “Apri. Una volta che hai 'immagine davanti ai tuoi occhi puoi iniziare a utilizzare gli strumenti messi a disposizione da paint
sulla barra laterale sinistra dello schermo: Pennello: Con questa funzione potrai disegnarti sopra qualsiasi cosa voglia. Seleziona: Questo tool serve ad evidenziarsi parti specifiche dell’immagine che poi si possono tagliarr fuori dall’intera fotografia. Gomma cancellino: Utile per cancellare parti dell’immagine selezionata. Riempimento colore: Con
questa funzione potrai riempire di colore le forme che hai disegnato. Testo: Consente di digitare testo sull’area in cui si sta lavorando. Leggi anche La guida completa per realizzare disegni in terza dimensioneUna volta finito il lavoro, salva I'immagine tramite “File” e poi “Salva come”. Come usare Paint 3D Strumenti per la modellazione 3D,
Possibilita’ di inserire oggetti tridimensionali predefiniti o crearli da zero, Opzioni avanzate per l'illuminazione ed Effetti speciali. Se vuoi portare la tua creativita’ a un livello superiore rispetto al programma base, allora ti consigliamo di provare Microsoft Paint 3D. Questa versione avanzata ti permette infatti oltre ad editare immagini anche la
possibilita’ di creazione modelli 3D. Il software ha una interfaccia grafica molto simile al programma base con alcune funzioni aggiuntive. Paint 3D e’ disponibile gratuitamente su Windows Store ma puoi provarlo solo se possiedi un computer dotato del sistema operativo Windows 10 Creators Update. Leggi anche Guida per l'apertura di file .xmlCome
usare Paint.NET Livelli, Opzioni avanzate per l'illuminazione, Regolazioni del colore e altro ancora. Infine, se stai cercando un software piu’ professionale e completo rispetto alle precedenti versioni, allora ti suggeriamo Paint.NET. Si tratta infatti del miglior sostituto gratuito a Photoshop sul mercato e offre agli utenti una vasta gamma di strumenti
utilizzabili sia sui file bitmap che vettorialiali. Oltre ai classici strumenti presentati dalle altre due versione (Pennello,Gomma,Riempi...) , questo software offre la possibilita’ di utilizzare i livelli, opzioni avanzate per l'illuminazione , regolazioni del colore e cosi via. Ce ne sono molte altre funzionalita’ che scoprirai mano a mano che utilizzerai il
programma sul tuo PC. Paint.NET e’ scaricabile gratuitamente dal sito web ufficiale ma chiede ai suoi utenti una certa conoscenza delle basi della progettazione grafica. In sintesi, Microsoft Paint e’ un ottimo programma per chi cerca uno strumento semplice ed efficace per modificare le proprie immagini su Windows. Se vuoi spingere la tua
creativita’ oltre ci sono le versioni piu’ avanzate come Paint 3D e Paint.NET che ti consentono di creare modelli in tre dimensioni e utilizzare tutti gli strumenti disponibili tramite un’interfaccia facile da usare anche se richiede una buona dose di pratica! #MicrosoftPaint #Windows #modificareimmagini #ritoccifoto #graficheminimaliste #Paint3D
#PaintNET Microsoft Paint € un'importante applicazione di Windows 11/10 utilizzata per creare o disegnare immagini diverse sull'area di disegno di Paint . L' applicazione Paint offre vari strumenti, diversi tipi di pennelli, forme e un'ampia tavolozza di colori per disegnare immagini e modificarle. Ti consente anche di scaricare un'immagine dal Web e
copiarla sulla tela o sulla pagina di Paint e modificarla nel modo desiderato! Come utilizzare Microsoft Paint in Windows 11/10 Per aprire 1' applicazione Paint , fare clic sul pulsante START > Windows Accessories > Paint OPPURE(OR) digitare Paint nella casella di ricerca sulla barra(Taskbar) delle applicazioni e quindi selezionare 1' applicazione Paint
dai risultati. La seguente finestra si aprira sullo schermo. Ecco come appare la tela Paint . Nella parte superiore della finestra di Paint , vedrai la barra(Toolbar) degli strumenti , dove puoi svolgere varie funzioni. Questa barra degli strumenti include la scheda File , la scheda (File)Home e la scheda Visualizza(View) . Esaminiamolo ora nel dettaglio. 1]
Casa La scheda Home ¢ la scheda predefinita quando si apre 1' applicazione Paint . Nella scheda Home , puoi eseguire varie funzioni relative all'immagine, agli appunti, agli strumenti, alle forme e ai colori. In Appunti(Clipboard) , puoi eseguire comandi come taglia, copia e incolla, in cui puoi tagliare o copiare una selezione dall'area di lavoro e
incollarla sulla tastiera. Nella sezione Immagine(Image) , puoi ritagliare, ridimensionare e ruotare 1'immagine. Puoi ruotare a sinistra ea destra di 90 gradi, ruotare di 180 gradi e capovolgere anche verticalmente e orizzontalmente. Il gruppo Strumenti(Tools) ti consentira di disegnare una linea a matita a forma libera con la larghezza selezionata,
aggiungere testo, scegliere un colore e usarlo per disegnare, riempire un'area sulla tela con il colore selezionato, utilizzare la lente di ingrandimento per un'area particolare sul tela e utilizzare la gomma per cancellare un'area particolare dell'immagine. Fare clic(Click) sul menu a discesa Pennelli per disegnare utilizzando diversi tipi di pennelli.
(Brushes)Troverai una varieta di pennelli con effetti diversi come pastello, pennarello, matita naturale, ecc. Nell'immagine di riferimento qui sotto, ho usato alcuni strumenti per mostrarti come appaiono e come si sentono. Qui ho usato lo strumento matita a mano libera, alcuni pennelli, lo strumento riempimento forma e lo strumento testo. Puoi anche
convertire il tuo disegno 2D in un'immagine 3D modificandolo in Paint 3D . Vai avanti ed esplora semplicemente! Con tutti questi strumenti, sei sicuro di rendere la tua foto attraente e semplicemente fantastica! Strumenti di testo Sulla tela di Paint, scegli la posizione in cui desideri aggiungere la casella di testo e digita il testo desiderato al suo
interno. Puoi formattare il testo selezionando il tipo di carattere, la dimensione del carattere, modificando il carattere in grassetto e corsivo e sottolineando o barrando il testo. E possibile scegliere il colore di primo piano desiderato e il colore di sfondo. Fare riferimento all'esempio mostrato di seguito. Sotto il gruppo Forme(Shapes) , puoi inserire
forme pronte come rettangolo, pentagono, diamante, stella, callout e cosi via. Fare clic(Click) su Contorno(Outline) per scegliere tra le varie opzioni come tinta unita, pastello, pennarello, olio, matita naturale, acquerello o anche senza contorno. Fare clic(Click) su Riempimento (Fill)forma(Shape) per selezionare il mezzo per il riempimento, ad esempio
tinta unita, pastello, pennarello, olio, matita naturale, acquerello o nessun riempimento. Nel menu a discesa Dimensioni(Size) , puoi selezionare la dimensione o la larghezza di un particolare strumento. Vedrai quattro variazioni in Dimensioni(Size) come 1px, 3px, 5px e 8px. Vedere un esempio mostrato di seguito. Ho usato alcuni strumenti come lo
strumento testo, la matita, i pennelli e il riempimento con uno strumento Colore(Color) per disegnare la seguente immagine. Seleziona la forma che desideri disegnare e la dimensione della larghezza dello strumento. Qui, ho selezionato una dimensione di 3px per la forma Lightning con un colore di contorno solido come il marrone e un riempimento a
pastello come giallo. Il gruppo Colori(Colors) include un'ampia tavolozza di colori che puoi scegliere per il tuo disegno. Puoi anche modificare con Paint 3D utilizzando strumenti avanzati, di cui parleremo in seguito in dettaglio in un altro post. Leggi(Read) : Suggerimenti e trucchi per Microsoft Paint . 2] Visualizza La scheda Visualizza(View) include
tre gruppi denominati Zoom , Mostra(Show) o nascondi e Visualizza(Display) . Il gruppo Zoom ti consente di ingrandire o rimpicciolire 1'immagine quanto vuoi per una migliore esperienza di visualizzazione, oppure puoi anche ingrandire esattamente il 100%. Sotto il gruppo Mostra o nascondi(Show or hide) troverai le impostazioni relative a righelli,
linee della griglia e barra di stato. Con l'aiuto di Righelli(Rulers) , puoi visualizzare e misurare 1'oggetto o un'immagine particolare sulla tua tela Paint . Le linee della griglia(Gridlines) ti aiuteranno ad allineare gli oggetti nella tua immagine. Selezionando o deselezionando 1' opzione Barra di stato(Status Bar) , puoi mostrarla o nasconderla nella parte
inferiore della finestra di Paint . Nel gruppo Display & possibile visualizzare 1'immagine a schermo intero(Full Screen) ; e puoi mostrare o nascondere la finestra delle miniature .(Thumbnail) 3] Archivio Nel menu File & possibile aprire un'immagine esistente o gia creata, creare una nuova immagine e salvare l'immagine corrente nella posizione
desiderata. E possibile importare file da uno scanner o da una fotocamera, stampare un'immagine e inviare un'immagine come allegato in un messaggio di posta elettronica. E possibile modificare lo sfondo del desktop impostando 1'immagine corrente come sfondo del desktop. E anche possibile modificare le proprieta(Properties) dell'immagine
corrente. E infine, vedrai 1' opzione Esci(Exit) per chiudere o uscire dall'applicazione. Barra degli strumenti di accesso rapido Nella parte in alto a sinistra della finestra di Paint , sopra la (Paint)barra(Toolbar) degli strumenti , vedrai la barra degli strumenti di accesso rapido(Quick Access Toolbar) . Qui troverai le scorciatoie per salvare l'immagine
corrente, annullare o ripetere 1'ultima azione e ridurre a icona, massimizzare e chiudere 1'applicazione. Puoi anche personalizzare la barra degli strumenti di accesso rapido secondo le tue esigenze. Troverai impostazioni aggiuntive qui per ridurre a icona la barra multifunzione, per mostrare la barra degli strumenti di accesso rapido sotto la barra
multifunzione, ecc. Quindi, vai avanti e personalizza e apporta modifiche alla barra degli strumenti di accesso rapido secondo le tue esigenze. Questo rendera il tuo lavoro molto piu facile e veloce. In questo post, in primo luogo, abbiamo visto i due modi principali su come aprire e avviare 1' applicazione Paint . E, in secondo luogo, abbiamo trattato
tutti i componenti della barra multifunzione e della barra degli strumenti di accesso rapido. Spero che questo post abbia coperto tutti i dettagli su come utilizzare 1' applicazione Paint e su come creare o disegnare una nuova immagine utilizzando i vari strumenti e accessori di Paint . Ora leggi(Now read) : Come utilizzare l'app Paint 3D in Windows
11/10 . Microsoft Paint is an important application of Windows 11/10 that is used to create or draw different pictures on the Paint canvas. The Paint application offers various tools, different kinds of brushes, shapes, and a wide palette of colors to draw pictures and to edit them. It also allows you to download a picture from the web and copy it on the
Paint canvas or page, and edit it the way you want! How to use Microsoft Paint in Windows 11/10 To open the Paint application, click on the START button > Windows Accessories > Paint OR type Paint in the search box on the Taskbar and then select the Paint application from the results. The following window will open on your screen. This is how
the Paint canvas looks like. At the top of the Paint window, you will see the Toolbar, where you can carry out various functions. This toolbar includes the File tab, Home tab, and View tab. Let us now look into it in detail. 1] Home The Home tab is the default tab when you open the Paint application. In the Home tab, you can carry out various functions



related to the image, clipboard, tools, shapes, and colors. Under Clipboard, you can perform commands such as cut, copy, and paste, where you can cut or copy a selection from the canvas and paste it on the keyboard. Under the Image section, you can crop, resize, and rotate the picture. You can rotate left and right to 90 degrees, rotate to 180
degrees and flip vertical and horizontal as well. The Tools group will allow you to draw a free form pencil line with the selected width, add text, pick a color and use it for drawing, fill an area on the canvas with the selected color, use the magnifier for a particular area on the canvas, and use the eraser to erase a particular area of the picture. Click on
the Brushes drop-down menu to draw using different kinds of brushes. You will find a variety of brushes with different effects such as crayon, marker, natural pencil, etc. In the reference picture below, I have used a few tools to show you how they look and feel. Here, I have used the free-form pencil tool, a few brushes, the shape fill tool, and the text
tool. You can also convert your 2D drawing into a 3D picture by editing it in Paint 3D. Go ahead and simply explore! With all these tools, you are sure to make your picture look attractive and simply awesome! Text Tools On your Paint canvas, choose the location where you want to add the text box and type the desired text in it. You can format the text
by selecting the font type, font size, changing the font to bold and italics, and underlining or striking through the text. You can choose the desired foreground color as well as the background color. Refer to the example shown below. Under the Shapes group, you can insert ready shapes such as rectangle, pentagon, diamond, star, callout, and so on.
Click on Outline to choose from the various options such as solid color, crayon, marker, oil, natural pencil, watercolor, or even no outline. Click on Shape Fill to select the medium for the fill, such as, solid color, crayon, marker, oil, natural pencil, watercolor, or no fill. Under the Size drop-down menu, you can select the size or width of a particular tool.
You will see four variations under Size such as 1px, 3px, 5px, and 8px. See an example shown below. I have used certain tools such as the text tool, pencil, brushes, and fill with a Color tool to draw the following picture. Select the shape you want to draw and the size of the width of the tool. Here, I have selected a 3px size for the Lightning shape with
a solid outline color like brown and a crayon fill as yellow. The Colors group includes a wide palette of colors that you can choose for your drawing. You can also edit with Paint 3D using advanced tools, which we will later cover in detail in another post. Read: Microsoft Paint Tips & Tricks. 2] View The View tab includes three groups named Zoom,
Show or hide, and Display. The Zoom group enables you to zoom in or zoom out into the picture as much as you want for a better viewing experience, or you can also zoom to exact 100%. Under the Show or hide group, you will find settings related to rulers, gridlines, and status bar. With the help of Rulers, you can view and measure the object or a
particular picture on your Paint canvas. Gridlines will help you to align objects in your picture. By checking or unchecking the Status Bar option, you can show or hide it at the bottom of the Paint window. In the Display group, you can view the picture in Full Screen; and you can show or hide the Thumbnail window. 3] File Under the File menu, you
can open an existing or already created picture, create a new picture, and save the current picture in the desired location. You can import files from a scanner or camera, print a picture, and send a picture as an attachment in an email message as well. You can change the desktop background by setting the current picture as the desktop background.
You can change the Properties of the current picture as well. And finally, you will see the Exit option to close or exit the application. Quick Access Toolbar On the top left side of the Paint window, above the Toolbar, you will see the Quick Access Toolbar. Here, you will find the shortcuts to save the current picture, undo or redo the last action, and
minimize, maximize, and close the application. You can also customize the quick access toolbar as per your requirements. You will find additional settings here to minimize the ribbon, to show the quick access toolbar below the ribbon, etc. So, go ahead and customize and make changes to the quick access toolbar as per your requirements. This will
make your work pretty easier and quick. In this post, firstly, we have seen the two main ways on how to open and begin the Paint application. And, secondly, we covered all the components of the ribbon and the quick access toolbar. I hope this post covered all the details on how to use the Paint application and how to create or draw a new picture by
using the various Paint tools and accessories. Now read: How to use Paint 3D App in Windows 11/10. Microsoft Paint, un tempo un semplice strumento grafico, & ora un’applicazione di progettazione a sé stante, alimentata da funzionalita piu recenti, come Cocreator basato sull’intelligenza artificiale. Ad un certo punto ’app potrebbe avere problemi ad
aprirsi o funzionare correttamente. Questo tutorial elenca le correzioni standard e non standard per MS Paint che non funziona su Windows. Se Microsoft Paint non si apre, nonostante sia in esecuzione con te come amministratore, potrebbe esserci un programma in background che interferisce con l’applicazione. Un avvio pulito, come mostrato qui,
risolvera questi conflitti software per darti un nuovo inizio. Aprire Configurazione di sistema dalla ricerca di Windows, che & necessario Esegui come amministratore. Puoi anche aprirlo digitando msconfig.exe nel menu dei comandi Esegui, che puoi visualizzare Vincita + R. Vai a Servizi scheda e controllare il file Nascondi tutti i servizi Microsoft
menu. Questo popolera tutti i servizi non Microsoft nella finestra. Clicca su Disabilitare tuttoseguito da Fare domanda a E OK. Mancia: I’avvio pulito & una delle soluzioni che consigliamo per i problemi comuni di Windows. Un’applicazione MS Paint obsoleta tende a bloccarsi e bloccarsi nella maggior parte dei casi. E molto semplice aggiornarlo da
Microsoft Store per farlo funzionare correttamente. Un altro motivo, tuttavia, & che Microsoft potrebbe introdurre alcuni errori di runtime in varie applicazioni, incluso Paint, durante un aggiornamento cumulativo o facoltativo. Questi problemi persistono fino al prossimo aggiornamento, che in genere introdurra una correzione. La soluzione &
mantenere Verifica aggiornamenti nel aggiornamento Windows impostazioni. Mancia: se non vuoi aspettare il prossimo aggiornamento, & facile disinstallare I’aggiornamento piu recente e attendere la correzione. Se MS Paint non funziona correttamente, le voci dell’identificatore di sicurezza (SID) potrebbero essere danneggiate e dovrai eliminarle.
Quando installi nuovamente 1’applicazione, le voci SID verranno riavviate. Apri ’editor del registro di Windows, utilizzando regedit.exe nel prompt dei comandi Esegui (Vincita + R). Successivamente, vai al seguente percorso: Computer\HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\AppxAllUserStore Quando apri il
AppxAllUserStore chiave, varie voci SID possono essere identificate tramite prefissi, come “S-1-S”. Espandi le sottochiavi per cercare eventuali voci SID relative a MS Paint. Dopo aver identificato la voce SID per Paint, fai clic con il pulsante destro del mouse su di essa Eliminare I’'immissione e chiudere il file Editor del registro. Disinstallare, quindi
reinstallare il programma dal Pannello di controllo. Il profilo SID danneggiato si cancellera da solo. Nota: prima di provare il metodo successivo, apri Colore dal suo Impostazioni dell’app nella ricerca di Windows. Prova la combinazione di Ripristina, riparazioneE disinstallarel. Potresti aver provato a disinstallare e reinstallare MS Paint per farlo
funzionare di nuovo, senza successo. In quanto linguaggio di scripting, PowerShell puo sovrascrivere qualsiasi programma o processo in background che interferisce con I’applicazione, poiché é pili potente dei tradizionali processi di disinstallazione. Esistono due modi per utilizzare PowerShell per disinstallare/reinstallare MS Paint. Apri PowerShell in
modalita amministratore e inserisci il comando seguente. Get-AppxPackage Microsoft. MSPaint | Remove-AppxPackage Reinstallare il pacchetto come mostrato qui. Get-AppxPackage -allusers Microsoft. MSPaint | Foreach {Add-AppxPackage -DisableDevelopmentMode -Register "$($_.InstallLocation)\AppXManifest.xml"} Questo ¢ il modo tradizionale
per disinstallare le applicazioni in PowerShell. E pill adatto per i sistemi Windows 10 e precedenti. Inserisci quanto segue per popolare la schermata di PowerShell con tutte le tue applicazioni in modalitd amministratore. Get-WmiObject -Class Win32 Product | Select-Object -Property Name Chiama il nome dell’applicazione Microsoft Paint, come
potrebbe essere indicato nella schermata di PowerShell. $MyApp = Get-WmiObject -Class Win32 Product | Where-Object{$ .Name -eq "Mspaint"} Dopo aver richiamato correttamente I’applicazione, disinstallala utilizzando il comando seguente: L’applicazione puo essere reinstallata utilizzando un file Get-Package cmdlet. Get-Package -Provider
Programs -IncludeWindowsInstaller -Name "/Name convention of your Paint application/" Mancia: vuoi avere piu successo con PowerShell? Scopri i comandi PowerShell piu essenziali per il tuo lavoro quotidiano. Subito dopo una reinstallazione, a volte € possibile semplicemente reinizializzare 1’applicazione Paint in PowerShell. Digita il seguente
comando in PowerShell in modalita amministratore. Get-AppxPackage *Microsoft.Paint* | Reset-AppxPackage Lo schermo si aggiornera automaticamente man mano che MS Paint si reinizializza, garantendo cosi I’apertura senza problemi. Paint, in quanto applicazione di Microsoft Store, &€ soggetta ad accumulo di cache. Cio puo far si che smetta di
funzionare improvvisamente. Svuotare la cache di tanto in tanto € essenziale per sbloccare 1’applicazione. Utilizzare il comando Esegui, Vincita + Re digitare wsrest.exe. Inizialmente verra avviata ’applicazione Microsoft Store. Inoltre cancellera automaticamente tutta la cache. Nota: se Microsoft Store non funziona per qualsiasi motivo, cio potrebbe
anche causare l'interruzione del funzionamento delle applicazioni connesse come Paint. Controlla il nostro elenco di correzioni. Se MS Paint non funziona o non si apre, riceverai diversi tipi di errori di sistema come “Impossibile trovare C:\Windows\System32\Mspaint.exe” o “Questa operazione e stata annullata a causa delle restrizioni in vigore su
questo computer. “ E possibile che esista una policy di gruppo locale che ti impedisce di accedere all’applicazione. Puoi contattare un amministratore di sistema in una rete condivisa oppure, se sei il proprietario del PC, aprire I’Editor criteri di gruppo locale utilizzando gpedit.msc nel comando Esegui. Navigare verso Criteri del computer locale ->
Configurazione utente -> Modelli amministrativi -> Sistema. Fare doppio clic su Non eseguire applicazioni Windows specificate. Se la politica di gruppo & abilitata nella nuova finestra, fare clic su Elenco delle applicazioni non consentite. Si aprira una nuova finestra pop-up in cui potrai verificare se sono presenti restrizioni di sistema su MS Paint. Per
annullare queste restrizioni, modificare I'impostazione in Disabilitatoquindi fare clic su Fare domanda a seguito da OK. Chiudi il programma. Mancia: le impostazioni dei criteri di gruppo creano problemi sul tuo dispositivo? Ripristinali facilmente per garantire che le app funzionino correttamente. Se hai installato nuovi caratteri, € probabile che
possano interferire con I’applicazione MS Paint in background, causandone arresti anomali e impedendone 1’apertura. Per evitare cio, potrebbe essere necessario eliminare i caratteri installati di recente. Vai a Windows Impostazioni utilizzando Vincita + IOseguito da Personalizzazione -> Caratteri. Disinstalla tutti i caratteri recenti. Una causa minore
del problema del mancato funzionamento di MS Paint su Windows & il malfunzionamento del framework .NET, qualcosa che puoi risolvere con DISM e altri comandi di sicurezza. Credito immagine: DALL-E. Tutti gli screenshot sono di Sayak Boral. Ci sono dei programmi presenti da tantissimo tempo sui nostri PC, che vediamo passare ogni giorno
sotto il nostro naso ma che, per un motivo o I’altro, non prendiamo mai in considerazione quanto meriterebbero. Uno dei primi esempi che mi vengono in mente e Paint, incluso “di serie” in tutte le versioni di Windows (comprese quelle piu vecchie, tra cui XP, Me, 98, 95 e perfino Windows 3.1): tutti lo hanno sul PC ma in pochissimi sanno come
sfruttarne appieno le potenzialita.Scommetto che anche tu non 1’hai mai usato, forse eccezion fatta per qualche occasione in cui hai dovuto aggiungere qualche scritta a una foto o eliminare le parti inutili di un’immagine. Beh, sappi che Paint puo essere usato anche per operazioni leggermente piu complesse che, solitamente, & meglio effettuare con
software piu “potenti” ma che, talvolta, puo essere pratico portare a termine anche con software cosi “easy”. Ad esempio, ti sei mai chiesto come sovrapporre due immagini con Paint, inserendo all’interno delle tue foto dei loghi, dei personaggi o dei disegni presi da altre immagini trovate in Rete? Scommetto di no, quindi rimediamo subito e vediamo
come si fa.Prima di iniziare ci tengo a dirti che, per questo tutorial, ho usato la versione di Paint presente su Windows 11, ma la procedura da seguire & praticamente identica su tutte le versioni di Windows. Inoltre provvedero a spiegarti come usare a tale scopo anche alcune soluzioni sviluppate da terze parti. Buona lettura e buon
divertimento!IndiceCome sovrapporre due immagini con Paint di WindowsSe vuoi imparare come sovrapporre due immagini con Paint, il primo passo che devi compiere & avviare il programma tramite il suo collegamento che si trova nel menu Start di Windows.Puoi trovarlo facilmente pigiando sul pulsante Start (il pulsante raffigurante il logo di
Windows collocata in basso, nella barra delle applicazioni), digitando il suo nome nel campo di ricerca visibile a schermo e cliccando sul primo risultato disponibile. In alternativa, puoi recarti direttamente nel percorso Tutte le app/Tutti i programmi e selezionare Paint da li.Nella finestra che si apre, apri il menu File che si trova in alto a sinistra,
seleziona la voce Apri dal menu che compare e apri la prima foto su cui intendi sovrapporre la seconda. La prima foto puo essere in qualsiasi formato e di qualsiasi dimensione, mentre la seconda per essere sovrapposta deve essere in formato PNG o GIF e avere uno sfondo trasparente. Nel caso il soggetto ritratto nella foto non dovesse avere lo sfondo
trasparente, puoi renderlo tale sfruttando servizi quali Remove.bg oppure una delle altre soluzioni elencate in questa guida.Una volta aperta la prima immagine, devi inserire in essa quella da sovrapporre. Apri, quindi, quest’ultima facendo doppio clic sulla sua miniatura, cosi da aprirla con I’applicazione Foto (se stai usando Windows 11/10) oppure
Raccolta foto (se utilizzi una versione di Windows meno recente), poi fai clic destro su di essa e seleziona la voce Copia dal menu che si apre.Ora, recati nella finestra di Paint in cui e presente I'immagine che hai aperto poc’anzi, quella che intendi usare a mo’ di sfondo, premi i tasti Ctrl+V per incollarla e sovrapporla e il gioco e fatto. Se necessario,
poi, sposta la seconda immagine sovrapposta alla prima trascinandola con il mouse nel punto desiderato e, quando sei pronto per farlo, salva il risultato finale sotto forma di immagine JPG, PNG, GIF o BMP, aprendo il menu File > Salva con nome (in alto a sinistra), seleziona il formato e la posizione in cui esportare il documento di output e il gioco &
fatto.Per il resto, al netto della possibilita indicata, un aggiornamento di fine 2023 legato al programma ha introdotto alcune funzionalita che potrebbero tornarti particolarmente utili in questo ambito. Infatti, mediante I'icona dell’omino con lo sfondo trasversale, collocata in alto a sinistra, risulta possibile rendere trasparente lo sfondo. Facendo poi
clic, invece, sull’opzione Livelli, che trovi in alto a destra, puoi far comparire sulla destra la scheda dei layer.E dunque premendo sul pulsante + presente in quest’ultima che puoi aggiungere un layer, in modo poi da poter copiare e incollare in esso I'immagine di sfondo che vuoi utilizzare. Per il resto, potrebbe semplicemente interessarti spostare in
alto il layer del soggetto, cosi da metterlo in primo piano, ma di fatto hai appena imparato come effettuare una sovrapposizione piu “professionale” mediante Paint.Va detto poi che con le piu recenti versioni del programma si e deciso anche di abbracciare l'intelligenza artificiale. In che senso? Mediante la pressione del pulsante Cocreator, collocato in
alto a destra, risulta possibile generare immagini e sfondi IA mediante un input testuale. Al momento in cui scrivo questa funzione & disponibile solamente in inglese e si passa per un sistema di crediti, ma potrebbe interessarti approfondire le FAQ ufficiali di Microsoft per maggiori dettagli.Come sovrapporre due immagini con Paint.NETLe soluzioni
presenti di default su Windows 11/10 non sono state di tuo gradimento? In tal caso, perché non provi a rivolgerti a Paint. NET? Quest’applicazione gratuita realizzata non da Microsoft ma da uno sviluppatore indipendente (disponibile anche sul Microsoft Store al prezzo di 7,99 euro una tantum, come supporto per il suo sviluppo), include alcune
funzioni avanzate molto utili, come la gestione dei livelli. Lascia che ti spieghi come avvalertene.Per prima cosa, scarica gratuitamente Paint.NET: recati sulla sua pagina di download e clicca sul link paint.net x.x.x situato in alto a destra (sotto la voce Get it now (free download). Al termine del download, apri I’archivio .zip che hai ottenuto, fai doppio
clic sul file .exe per avviare l'installazione di Paint.NET e completa il setup cliccando sul pulsante Si, spunta la casella Rapida, fai clic sul pulsante Avanti, metti la spunta sulla casella Accetto e, per concludere, clicca sui bottoni Avanti e Fine.Una volta che avrai installato e avviato il programma, recati nel menu File > Apri da quest’ultimo e seleziona la
prima immagine, quella che intendi usare come sfondo. Successivamente, trascina la seconda immagine nella finestra del programma e seleziona la voce Aggiungi livello nel riquadro apertosi a schermo.Qualora dovesse sorgere la necessita di scontornare un soggetto dallo sfondo, sappi che Paint.NET presenta vari tool utili a questo scopo, come lo
strumento Selezione con lazo, di cui ti ho parlato approfonditamente in quest’altra guida.Una volta che avrai sovrapposto (ed eventualmente scontornato) la seconda immagine alla prima, ridimensionala e trascinala nel punto desiderato, cosi da realizzare il fotomontaggio come meglio credi, e infine recati nel menu File > Salva con nome per salvare la
foto di output selezionando posizione e formato della foto realizzata con la sovrapposizione. Salvatore Aranzulla & il blogger e divulgatore informatico piu letto in Italia. Noto per aver scoperto delle vulnerabilita nei siti di Google e Microsoft. Collabora con riviste di informatica e cura la rubrica tecnologica del quotidiano I1 Messaggero. E il fondatore di
Aranzulla.it, uno dei trenta siti piu visitati d'Italia, nel quale risponde con semplicita a migliaia di dubbi di tipo informatico. Ha pubblicato per Mondadori e Mondadori Informatica.
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